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INTRODUCTION
When developing applications using a network protocol
standard, it is helpful to “see” the data being
transmitted between the devices. When the network
protocol standard uses a physical medium, a logic
analyzer can be used to view the data transmitted over
the cable. A different method must be used during the
development of an infrared application, however, since
the medium being used for the transfer of information is
light (IR), and not a physical medium that can be
connected to a cable.

This application note will discuss the implementation of
an “IR Sniffer” using the MCP2120 Developer’s Board
connected to a PC running a program called “Listen32”.
This application note will: 

• Discuss the requirements for capturing the IR 
data

• Provide an introduction on how to read the 
captured data

• Discuss some of the system’s limitations
This implementation provides a low-cost method for
“seeing” the IR data communication between a Primary
Device and a Secondary Device. While there are third-
party tools that can accomplish this, these tools tend to
be quite expensive.

Figure 1 shows an IrDA® standard system where a
Palm™ PDA device is communicating with an
embedded system. In this example, the Palm PDA
operates as the Primary Device and the embedded
system operates as the Secondary Device.

For the purposes of this Application Note, it is assumed
that the reader has an understanding of the IrDA
Standard Protocol (and its terminology) and the
connection sequence between a Primary Device and a
Secondary Device. An overview of this sequence can
be found in Appendix A: “Overview of the IrDA®
Standard Connection Sequence”, the MCP21XX
device data sheets and the IrDA.org documentation
(located at www.irda.org).
The MCP2120 Developer’s Board is contained in the
MCP2120/MCP2150 Developer’s Kit, Part Number
DM163008.

FIGURE 1: PALM™ PDA - EMBEDDED SYSTEM BLOCK DIAGRAM   
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THE HARDWARE SETUP
To capture the data transmitted from the Primary
Device and the Secondary Device, the MCP2120
Developer’s Board must be able to “see” the IR data
from both devices. Since IR is directional, something
must be done to ensure that the light from both devices
can be detected by the MCP2120 Developer’s Board
receiver. This is accomplished by using a little trick.
Most IrDA standard devices will not receive when they
are transmitting because they don’t want to pick up the
data they just transmitted. Therefore, if a mirror or
bright white paper is placed opposite the device, it
would not see the reflected data (see Figure 2).    

The MCP2120 Developer’s Board is actually stacked
on top of the embedded system (Secondary Device),
with the optical transceivers close to each other, while
the mirror/white paper is just above the PDA IR window
(see Figure 3).

Figure A-1 shows an overview of the IrDA standard
connection sequence and some common IrDA
standard terminology.

FIGURE 2: IR SNIFFER SETUP USING THE MCP2120 DEVELOPER’S BOARD     

FIGURE 3: FRONT VIEWS OF IR SNIFFER SETUP       

Note: If the captured data does not follow the
expectation for frame sequence, then you
may need to:
1. Adjust your reflective surface 
2. Use a better refective surface. 
The success of this method is also
dependent on the strength of the transmit-
ters and the sensitivity of the receiver
circuit.
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MCP2120 Developer’s Board Setup
The MCP2120 is an encoder/decoder device. That is, it
converts between the UART (at a specified baud rate)
and IrDA standard data formats. For this application (IR
sniffer), we are only using the decoding capabilities
(i.e., converting from the IrDA standard data format to
the UART data format).

When “sniffing” IrDA standard IR data, the protocol
used determines how the IR baud rate will behave. For
the IrCOMM protocol, the capabilities of the Primary
Device and the Secondary Device will determine the
negotiated IR baud rate. All communication starts at
9600 Baud. Most Primary Devices support
communication up to 115.2 Kbaud. The MCP215X
devices support communication up to 115.2 Kbaud,
while the MCP2140 is fixed at 9600 Baud.

What does this mean? Well, for the MCP2140, the
MCP2120 Developer’s Board can be configured for
9600 baud, and the entire IR communication would be
captured. Appendix B: “MCP2140 IR Communica-
tion Capture” shows the capture of IR communication
between the MCP2140 and a Palm PDA.

However, with the MCP215X devices, the baud rate
can be negotiated to one of the available selections
between 9600 Baud and 115.2 Kbaud. In most cases,
the Primary Device will support 115.2 Kbaud.

If the MCP2120 Developer’s Board was configured for
9600 Baud, only the first part of the IR communication
would be captured until the Primary Device and
Secondary Device switched baud rates. Likewise, if the
MCP2120 Developer’s Board was configured for
115.2 Kbaud, then only the second part of the IR
communication would be captured (i.e., from the point
that the Primary Device and Secondary Device
switched from 9600 Baud to the new baud rate -
115.2 Kbaud). Appendix C: “MCP215x IR Communi-
cation Capture” shows two captures of IR communi-
cation between the MCP2150 and a PDA. The first at
9600 baud and the second at 115.2 Kbaud.
Figure 4 shows the jumper configuration for the general
setup of the MCP2120 Developer’s Board, while
Figure 5 shows how to configure the jumpers for the
two main baud rates (9600 baud and 115200 baud).
The baud rate is dependent on the MCP2120’s
operational frequency. These baud rate jumper settings
are based on the MCP2120 having a crystal frequency
of 7.3728 MHz. For additional information on the oper-
ation of the MCP2120 Developer’s Board, please refer
to the MCP2120/MCP2150 Developer’s Board User
Guide (DS51246).

FIGURE 4: MCP2120 DEVELOPER’S BOARD JUMPER SETUP    

U
5

J5

D4 C15

C12

C13 C14

C9

C5

C1

J2

MCP2120 Developer’s Board
02-01608 Rev. 1

U1

D
B9

J1

J4

R14

CR1 C4

C7

C8

R1

Q1

JP5

U3

R2 C2

C3

H
ea

de
r

R
X

TX M
O

D
E

R
TS

J3 +5V GND

R13

C16

JP3:JP1
000 = Fosc/768
001 = Fosc/384
010 = Fosc/192
011 = Fosc/128
100 = Fosc/64
111 = S/W Baud
Open = 0

Integrated
Transceiver

U6

R8 R7 R6

R4 JP4

(MCP2120)
Open = Enabled

R9 D3

Y
1

D6 D2 U2

C6

R3

C10 U4

R5
R11R10

C
17

Component
Transceiver

J7J6 R12

D1
D5

C18

R15C11

These two jumpers select the 
source of the Host signals.

DB9 is source. 

J1 and J4 

These two jumpers select the 
optical transceiver logic. Both 

Integrated Transceiver

J6 and J7 

jumpers should connect the 
same pin positions.

PC UART configuration for 

Hardware Baud Selection 

MCP2120 Enable/Disable

Enabled 

Hardware/Software Baud mode



AN923

DS00923A-page 4   2004 Microchip Technology Inc.

FIGURE 5: SELECTING THE BAUD RATE FOR THE MCP2120 DEVELOPER’S BOARD    
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THE SOFTWARE
To capture the data on the PC from the MCP2120
Developer’s Board, a third-party program called
“Listen32” was used. Listen32 was chosen due to its
capability to display the data that is received in several
formats, including hexadecimal. This is required
because numerous hex values are not displayable
when using many terminal programs since they only
display the ASCII character (many hex values are non-
printing characters). 
Listen32 was developed by Win-Tech Software Design.
Their web site is: 

http://www.win-tech.com 

To use the program, you will need to select the Setup
→ Hardware menu. Here you will select the character-
istics of the UART port that the MCP2120 Developer’s
Board is connected to. For both the MCP2140 and
MCP215X devices, the port should be configured for
“No parity”, 8 data bits and 1 Stop bit. The baud rate
MUST match the baud rate of the MCP2120 Devel-
oper’s Board and should match the IR baud rate that
you wish to monitor. Table 1 shows how the baud rates
will work with the MCP21XX devices. Then select OK.

TABLE 1: LISTEN32 BAUD RATE 
SELECTION (2)  

Ensure that the program displays the information in the
correct numerical base (Num Base). Navigate to the
Setup → Preferences → Num Base menu and select
Hex. Then select OK. This will ensure that you see the
hex value of the data that is received.

Before you start the capture, you should clear the
Listen32 receive buffer. This is done by selecting Clear
Buffer from the Edit pull-down menu (Edit → Clear
Buffer).
Now you are ready to use Listen32 for capturing data.
You can do this by either clicking on the “green light”
icon (in the tool bar), or by selecting File → New/
Collect. Once this is done, Listen32 will prompt you to
specify the serial port, for which you will select the port
that is connected to the MCP2120 Developer’s Board.
Once the IR communication is complete, clicking on
the “red light” icon (in the tool bar) ends the data-cap-
ture process. You can then save the file by selecting
Save As from the File pull-down menu (File → Save
As). It is suggested that you select the .TXT format
(not the .LSN) so that you can format the captured
information in your favorite text editor.

Baud Rate MCP2140 MCP215x

9600 Entire IR 
Communication 
(NDM, Discovery 
and NRM)

NDM and 
Discovery up to 
when baud rate 
changes (1) 

115200 N.A. Discovery after 
baud rate changes 
and NRM

Note 1: Entire IR Communication (NDM,
Discovery and NRM) if Primary Device
specifies 9600 baud rate in Discovery
mode.

2: To better understand what the terms
“NDM”, “Discovery” and “NRM” represent,
please refer to Appendix A: “Overview
of the IrDA® Standard Connection
Sequence”.
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LIMITATIONS
Some of the limitations of this technique are discussed
below, and depend on the MCP21XX protocol handling
device used.

For a System using an MCP2140 Device
This technique will capture the entire IR communication
since the IR data remains at 9600 Baud for all states
(NDM, Discovery and NRM). 
You will need to parse the saved text file from the
Listen32 program.

For a System using an MCP215X Device
If the Primary Device (such as a PC or PDA) will
negotiate a communication baud rate greater then
9600 Baud, then either:
1. the MCP2120 Developer’s Board can be

configured to capture the first portion of the IR
communication, when IR data is transmitted at
9600 Baud. This occurs during the NDM and
Discovery states, up to where the IR Baud rate
is changed, or 

2. the MCP2120 Developer’s Board can be config-
ured to capture the second portion of the IR
communication, when IR data is transmitted at
faster than 9600 Baud (such as 115.2 Kbaud).
This occurs during the Discovery state once the
IR baud rate is changed, and the NRM state.

In these cases, you are not able to see the entire IR
communication in a single capture.

If the Primary Device’s baud rate will remain at
9600 Baud, the entire IR communication can be
captured.

You will also need to parse the saved text file from the
Listen32 program.

IR CAPTURE EXAMPLES
An embedded system that transmits a 250 byte table to
a PDA was implemented. The embedded system’s
host controller will send the data to the MCP21XX
device, which will then format the data for the IrCOMM
frame and transmit to the PDA. Each appendix will
show the data as it was saved by the Listen32 program
(in .TXT format), and then that data formatted into the
IR frames.
Appendix B: “MCP2140 IR Communication Cap-
ture” shows the capture of IR communication between
the MCP2140 and a PDA.

Appendix C: “MCP215x IR Communication Cap-
ture” shows two captures of IR communication
between the MCP2150 and a PDA. The first at
9600 Baud and the second at 115.2 Kbaud.

The beginning of a frame (BOF) will start with a C0h
character, but may have preceding FFh characters.
(See Figure B-1, Frame 1). The end of the frame is
signified with a C1h character. Figure 6 shows the
structure of the IrLAP frame.

FIGURE 6: IRLAP FRAME

The address byte (A field) is odd for the Primary
Device, as well as the Secondary Device (See
Figure B-1, Frames 1 and 2). The control byte (C field)
differentiates between different types of frames. The
information field (I field) carries the data. If the first 4
characters of the I field are xxh:04h:00h:00h, the
following information in the I field is data payload. That
is, this is the data that the host controller is sending to
the Primary Device (See Figure B-1, Frame 30).

SUMMARY
It is sometimes useful in the debugging process of an
IrDA standard system to monitor the IR communica-
tions. The MCP2120 Developer’s Board allows the
implementation of a low-cost IR sniffer, which will assist
in the system development of your application from
both the Primary Device application program to the
embedded system (Secondary Device) hardware and
firmware.

N BOF BOF A C FCSI EOF

N•C0h + C0h payload 2
bytes C1h

or
N•FFh + C0h
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APPENDIX A: OVERVIEW OF THE IRDA® STANDARD CONNECTION SEQUENCE

FIGURE A-1: CONNECTION SEQUENCE
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APPENDIX B: MCP2140 IR COMMUNICATION CAPTURE

FIGURE B-1: MCP2140 RAW CAPTURE @ 9600 BAUD
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FIGURE B-1: MCP2140 FORMATTED CAPTURE @ 9600 BAUD - PAGE 1       

Frame  
#

Frame 
Sent By Frame Data

1

2

P

S

[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][68][ac][38][48]
    [ff][ff][ff][ff][01][00][00][7b][bd][c1]
[c0][fe][bf][01][b5][b5][b5][b5][68][ac][38][48][01][00][00][90][04][00]
    [4d][43][50][32][31][34][30][20][41][35][f0][6f][c1]

3

4

5

6

7

8

P

P

P

P

P

P

[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][68][ac][38][48]
    [ff][ff][ff][ff][01][01][00][a3][a4][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][68][ac][38][48]
    [ff][ff][ff][ff][01][02][00][cb][8e][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][68][ac][38][48]
    [ff][ff][ff][ff][01][03][00][13][97][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][68][ac][38][48]
    [ff][ff][ff][ff][01][04][00][1b][da][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][68][ac][38][48]
    [ff][ff][ff][ff][01][05][00][c3][c3][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][68][ac][38][48]
    [ff][ff][ff][ff][01][ff][00][82][04][00][49][72][43][4f][4d][4d][d0][c7][c1]

9

10

P

S

[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][93][68][ac][38][48][b5]
    [b5][b5][b5][3e][01][01][3f][82][01][01][83][01][0f][84][01][01][85]
    [01][08][86][01][07][08][01][ff][83][7d][e0][c1]
[c0][3e][73][b5][b5][b5][b5][68][ac][38][48][01][01][02][82][01][01][83]
    [01][01][84][01][01][85][01][80][86][01][07][08][01][ff][b9][15][c1]

11
12
13
14
15
16

P
S
P
S
P
S

[ff][c0][3f][11][25][3b][c1]
[c0][3e][11][fd][22][c1]
[c0][3f][10][80][01][01][00][fc][d7][c1]
[c0][3e][31][ff][03][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][30][81][00][81][00][ed][79][c1]

17

18
19
20
21
22

P

S
P
S
P
S

[c0][3f][32][00][01][84][0b][49][72][44][41][3a][49][72][43][4f][4d][4d]
    [13][49][72][44][41][3a][54][69][6e][79][54][50][3a][4c][73][61][70]
    [53][65][6c][64][f6][c1]
[c0][3e][52][01][00][84][00][00][01][00][04][01][00][00][00][04][d3][47][c1]
[c0][3f][54][84][02][01][00][01][03][00][01][04][1f][ad][c1]
[c0][3e][74][82][04][81][00][05][1a][e6][c1]
[c0][3f][71][23][58][c1]
[c0][3e][71][fb][41][c1]

23

24
25
26
27
28

P

S
P
S
P
S

[c0][3f][76][04][02][00][17][10][04][00][00][c2][00][11][01][03][12][01]
    [00][13][02][11][13][14][02][13][11][20][01][0c][af][a8][c1]
[c0][3e][96][02][04][01][1a][1c][c1]
[c0][3f][91][2d][bf][c1]
[c0][3e][91][f5][a6][c1]
[c0][3f][98][04][02][00][00][35][cc][57][c1]
[c0][3e][b8][02][04][01][0b][3d][c1]

29
30

P
S

[c0][3f][b1][2f][9e][c1]
[c0][3e][ba][02][04][00][00]
-------------------------------------------------------
[31][32][33][34][35][36][37][38][0d][0a]
[32][42][43][44][45][46][47][48][0d][0a]
[33][32][33]
-------------------------------------------------------
[15][34][c1]

Legend: P = Primary Device S = Secondary Device

Data Payload
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FIGURE B-2: MCP2140 FORMATTED CAPTURE @ 9600 BAUD - PAGE 2

Frame 
# 

Frame 
Sent By Frame Data

31
32
33
34

P
S
P
S

[c0][3f][da][04][02][05][f0][52][c1]
[c0][3e][d1][f1][e4][c1]
[c0][3f][d1][29][fd][c1]
[c0][3e][dc][02][04][00][00]
-------------------------------------------------------
            [34][35][36][37][38][0d][0a]
[34][62][63][64][65][66][67][68][0d][0a]
[35][32][33][34][35][36]
-------------------------------------------------------
[25][cd][c1]

35
36
37
38

P
S
P
S

[c0][3f][fc][04][02][01][1d][d0][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][f1][2b][dc][c1]
[c0][3e][fe][02][04][00][00]
-------------------------------------------------------
                        [37][38][0d][0a]
[36][42][43][44][45][46][47][48][0d][0a]
[37][32][33][34][35][36][37][38][0d]
-------------------------------------------------------
[1c][dd][c1]

39
40
41
42

P
S
P
S

[c0][3f][1e][04][02][01][e1][5d][c1]
[c0][3e][11][fd][22][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][10][02][04][00][00]
-------------------------------------------------------
                                    [0a]
[38][62][63][64][65][66][67][68][0d][0a]
[39][32][33][34][35][36][37][38][0d][0a]
[41][42]
-------------------------------------------------------
[cb][6a][c1]

43
44
45
46

P
S
P
S

[c0][3f][30][04][02][01][f0][7c][c1]
[c0][3e][31][ff][03][c1]
[c0][3f][31][27][1a][c1]
[c0][3e][32][02][04][00][00]
-------------------------------------------------------
        [43][44][45][46][47][48][0d][0a]
[42][32][33][34][35][36][37][38][0d][0a]
[43][62][63][64][65]
-------------------------------------------------------
[46][04][c1]

47
48
49
50

P
S
P
S

[c0][3f][52][04][02][01][62][dc][c1]
[c0][3e][51][f9][60][c1]
[c0][3f][51][21][79][c1]
[c0][3e][54][02][04][00][00]
-------------------------------------------------------
                    [66][67][68][0d][0a]
[44][32][33][34][35][36][37][38][0d][0a]
[45][42][43][44][45][46][47][48]
-------------------------------------------------------
[df][d6][c1]

Legend: P = Primary Device S = Secondary Device

Data Payload

Data Payload

Data Payload

Data Payload

Data Payload
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FIGURE B-3: MCP2140 FORMATTED CAPTURE @ 9600 BAUD - PAGE 3

Frame
#

Frame 
Sent By Frame Data

51
52

P
S

[c0][3f][71][23][58][c1]
[c0][3e][56][02][04][00][00]
-------------------------------------------------------
                                [0d][0a]
[46][32][33][34][35][36][37][38][0d][0a]
[31][62][63][64][65][66][67][68][0d][0a]
[32]
-------------------------------------------------------
[5c][ae][c1]

53
54
55
56

P
S
P
S

[c0][3f][94][04][02][01][21][ac][c1]
[c0][3e][71][fb][41][c1]
[c0][3f][91][2d][bf][c1]
[c0][3e][78][02][04][00][00]
-------------------------------------------------------
    [32][33][34][35][36][37][38][0d][0a]
[33][42][43][44][45][46][47][48][0d][0a]
[34][32][33][34]
-------------------------------------------------------
[16][2e][c1]

57
58
59
60

P
S
P
S

[c0][3f][b6][04][02][02][9f][28][c1]
[c0][3e][91][f5][a6][c1]
[c0][3f][b1][2f][9e][c1]
[c0][3e][9a][02][04][00][00]
-------------------------------------------------------
                [35][36][37][38][0d][0a]
[35][62][63][64][65][66][67][68][0d][0a]
[36][32][33][34][35][36][37]
-------------------------------------------------------
[0e][4f][c1]

61
62
63
64

P
S
P
S

[c0][3f][d8][04][02][01][a2][2d][c1]
[c0][3e][b1][f7][87][c1]
[c0][3f][d1][29][fd][c1]
[c0][3e][bc][02][04][00][00]
-------------------------------------------------------
                            [38][0d][0a]
[37][42][43][44][45][46][47][48][0d][0a]
[38][32][33][34][35][36][37][38][0d]
-------------------------------------------------------
[3d][ca][c1]

65
66
67
68

P
S
P
S

[c0][3f][fa][04][02][01][87][9b][c1]
[c0][3e][d1][f1][e4][c1]
[c0][3f][f1][2b][dc][c1]
[c0][3e][de][02][04][00][00]
-------------------------------------------------------
                                    [0a]
[39][62][63][64][65][66][67][68][0d]
-------------------------------------------------------
[af][c9][c1]

Legend: P = Primary Device S = Secondary Device

Data Payload

Data Payload

Data Payload

Data Payload

Data Payload
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FIGURE B-4: MCP2140 FORMATTED CAPTURE @ 9600 BAUD - PAGE 4

Frame
# 

Frame 
Sent By Frame Data

69
70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104

P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S

[c0][3f][11][25][3b][c1]
[c0][3e][d1][f1][e4][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][d1][f1][e4][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][d1][f1][e4][c1]
[c0][3f][1c][04][02][01][97][64][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]
[c0][3f][11][25][3b][c1]
[c0][3e][f1][f3][c5][c1]

105
106
107
108
109
110

P
S
P
P
P
P

[c0][3f][53][33][5a][c1]
[c0][3e][53][eb][43][c1]
[c0][3f][53][33][5a][c1]
[c0][3f][53][33][5a][c1]
[c0][3f][53][33][5a][c1]
[c0][3f][53][33][5a][c1][ff][ff]

Legend: P = Primary Device S = Secondary Device
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APPENDIX C: MCP215X IR COMMUNICATION CAPTURE

FIGURE C-1: MCP2150 RAW CAPTURE @ 9600 BAUD
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FIGURE C-1: MCP2150 FORMATTED CAPTURE @ 9600 BAUD - PAGE 1

Frame
# 

Frame 
Sent By Frame Data

1

2

3

4

P

P

P

S

[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][02][3c][00][43]
    [ff][ff][ff][ff][01][00][00][d3][25][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][02][3c][00][43]
    [ff][ff][ff][ff][01][01][00][0b][3c][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][02][3c][00][43]
    [ff][ff][ff][ff][01][02][00][63][16][c1]
[c0][c0][c0][c0][c0][c0][c0][c0][c0][c0][c0][fe][bf][01][b5][b5][b5][b5]
    [02][3c][00][43][01][02][00][90][04][00][47][65][6e][65][72][69][63]
    [20][49][72][44][41][28][ef][c1]

5

6

7

8

9

10

P

P

P

P

P

S

[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][02][3c][00][43]
    [ff][ff][ff][ff][01][03][00][bb][0f][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][02][3c][00][43]
    [ff][ff][ff][ff][01][04][00][b3][42][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][02][3c][00][43]
    [ff][ff][ff][ff][01][05][00][6b][5b][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][3f][01][02][3c][00][43]
    [ff][ff][ff][ff][01][ff][00][82][04][00][49][72][43][4f][4d][4d][d2]
    [36][c1]
[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][c0][ff][93][02][3c][00][43][b5]
    [b5][b5][b5][84][01][01][3f][82][01][01][83][01][0f][84][01][01][85]
    [01][08][86][01][07][08][01][ff][16][9b][c1]
[c0][c0][c0][c0][c0][c0][c0][c0][c0][c0][c0][84][73][b5][b5][b5][b5][02]
    [3c][00][43][01][01][3e][82][01][01][83][01][01][84][01][01][85][01]
    [80][86][01][01][08][01][ff][70][1b][c1]

11 Note 1 [ff][80][e0][02][ff][e0][01][00][fc][c2][00][00][00][ff][00][00][02][e0]
    [00][fe][80][e0][c0][00][00][f8][00][f0][00][e0][02][fe][00][81][00]
    [00][00][00][00][00][00][c0][81][00][00][00][00][00][00][00][c0][02]
    [00][00][00][00][00][00][00][c0][00][00][00][00][00][00][00][00][ff]
    [03][e0][81][e0][80][e0][80][e0][80][e0][00][e0][80][e0][80][e0][80]
    [e0][81][e0][81][e0][81][e0][80][e0][80][e0][80][e0][81][80][80][81]
    [ff][ff]

Legend: P = Primary Device S = Secondary Device

Note 1: The information captured here is “garbage data”. That is, the data that was communicated between the
Primary Device and Secondary Device at 115200 baud, but captured by the MCP2120 Developer’s Board
at 9600 baud. 
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FIGURE C-2: MCP2150 RAW CAPTURE @ 115200 BAUD
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FIGURE C-3: MCP2150 FORMATTED CAPTURE @ 115200 BAUD - PAGE 1

Frame
# 

Frame 
Sent By Frame Data

Note 1 [ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff]
    ................[ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff][ff]

P
S
P
S
P
S
P

S

[c0][db][11][dc][b5][c1]
[c0][da][11][04][ac][c1]
[c0][db][10][80][01][01][00][43][45][c1]
[c0][da][31][06][8d][c1]
[c0][db][11][dc][b5][c1]
[c0][da][30][81][00][81][00][47][d9][ff][f6][c1]
[c0][db][32][00][01][84][0b][49][72][44][41][3a][49][72][43][4f][4d][4d]
    [13][49][72][44][41][3a][54][69][6e][79][54][50][3a][4c][73][61][70]
    [53][65][6c][8d][c2][c1]
[c0][da][52][01][00][84][00][00][01][00][04][01][00][00][00][04][74][86][c1]

P
S
P
S
P

S
P
S
P
S

[c0][db][54][84][02][01][00][01][03][00][01][04][de][4e][c1]
[c0][da][74][82][04][81][00][05][f4][ab][c1]
[c0][db][71][da][d6][c1]
[c0][da][71][02][cf][c1]
[c0][db][76][04][02][00][17][10][04][00][00][c2][00][11][01][03][12][01]
    [00][13][02][11][13][14][02][13][11][20][01][0c][17][5b][c1]
[c0][da][96][02][04][00][03][21][01][7d][e0][35][81][c1]
[c0][db][98][04][02][04][4e][6a][c1]
[c0][da][b1][0e][09][c1]
[c0][db][9a][04][02][00][00][35][74][12][c1]
[c0][da][d8][02][04][01][19][a2][c1]

P
S

[c0][db][b1][d6][10][c1]
[c0][da][da][02][04][00][00]
-------------------------------------------------------
[31][32][33][34][35][36][37][38][0d][0a]
[32][42][43][44][45][46][47][48][0d][0a]
[33][32][33][34][35][36][37][38][0d][0a]
[34][62][63][64][65][66][67][68][0d][0a]
[35][32][33][34][35][36][37][38][0d][0a]
[36][42][43][44][45][46][47][48][0d][0a]
[37][32][33][34]
-------------------------------------------------------
[b3][7f][c1]

P
S

[c0][db][d1][d0][73][c1]
[c0][da][dc][02][04][00][00]
-------------------------------------------------------
                [35][36][37][38][0d][0a]
[38][62][63][64][65][66][67][68][0d][0a]
[39][32][33][34][35][36][37][38][0d][0a]
[41][42][43][44][45][46][47][48][0d][0a]
[42][32][33][34][35][36][37][38][0d][0a]
[43][62][63][64][65][66][67][68][0d][0a]
[44][32][33][34][35][36][37][38]
-------------------------------------------------------
[65][62][c1]

Legend: P = Primary Device S = Secondary Device
Note 1: The information captured here is “garbage data”. That is, the data that was communicated between the

Primary Device and Secondary Device at 9600 baud, but captured by the MCP2120 Developer’s Board at
115200 baud. Only a portion of this “garbage data” is shown due to space limitations (indicated by .......).

Data Payload

Data Payload
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FIGURE C-4: MCP2150 FORMATTED CAPTURE @ 115200 BAUD - PAGE 2

Frame
# 

Frame 
Sent By Frame Data

P
S

[c0][db][fc][04][02][01][eb][d6][c1]
[c0][da][fe][02][04][00][00]
-------------------------------------------------------
                                [0d][0a]
[45][42][43][44][45][46][47][48][0d][0a]
[46][32][33][34][35][36][37][38][0d][0a]
[31][62][63][64][65][66][67][68][0d][0a]
[32][32][33][34][35][36][37][38][0d][0a]
[33][42][43][44][45][46][47][48][0d][0a]
[34][32][33][34][35][36][37][38][0d][0a]
[35][62]
-------------------------------------------------------
[2d][c7][c1]

P
S

[c0][db][1e][04][02][01][17][5b][c1]
[c0][da][10][02][04][00][00]
-------------------------------------------------------
        [63][64][65][66][67][68][0d][0a]
[36][32][33][34][35][36][37][38][0d][0a]
[37][42][43][44][45][46][47][48][0d][0a]
[38][32][33][34][35][36][37][38][0d][0a]
[39][62][63][64][65][66][67][68][0d][0a]
[61][32][33][34][35][36][37][38][0d][0a]
-------------------------------------------------------
[11][7d][e1][c1]

P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S

[c0][db][30][04][02][01][06][7a][c1]
[c0][da][31][06][8d][c1]
[c0][db][31][de][94][c1]
[c0][da][31][06][8d][c1]
[c0][db][31][de][94][c1]
[c0][da][31][06][8d][c1]
[c0][db][31][de][94][c1]
[c0][da][31][06][8d][c1]
[c0][db][31][de][94][c1]
[c0][da][31][06][8d][c1]
[c0][db][32][04][02][01][70][43][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]

Legend: P = Primary Device S = Secondary Device

Data Payload

Data Payload
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FIGURE C-5: MCP2150 FORMATTED CAPTURE @ 115200 BAUD - PAGE 3

Frame
# 

Frame 
Sent By Frame Data

P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
S
P
P
P
P

[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][31][de][94][c1]
[c0][da][51][00][ee][c1]
[c0][db][53][ca][d4][c1]
[c0][da][53][12][cd][c1]
[c0][db][53][ca][d4][c1]
[c0][db][53][ca][d4][c1]
[c0][db][53][ca][d4][c1]
[c0][db][53][ca][d4][c1][ff][ff]

Legend: P = Primary Device S = Secondary Device
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Fax: 49-89-627-144-44
Italy
Via Quasimodo, 12
20025 Legnano (MI)
Milan, Italy 
Tel: 39-0331-742611  
Fax: 39-0331-466781
Netherlands
P. A. De Biesbosch 14
NL-5152 SC Drunen, Netherlands
Tel: 31-416-690399 
Fax: 31-416-690340
United Kingdom
505 Eskdale Road
Winnersh Triangle
Wokingham 
Berkshire, England RG41 5TU
Tel: 44-118-921-5869
Fax: 44-118-921-5820
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WORLDWIDE SALES AND SERVICE


